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Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is its
most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being said
at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

R&S UPV-K92 provides all tests specified in TIA-1042 version 1.0. It uses the
NORMAL real speech signal for sending and receiving frequency response and
loudness rating measurements and the ECHOLOSS speech signal for the echo
loss measurement.

An additional test case for peak acoustic level is provided. This test uses the
PEAKLEV test signal.

For sending measurements, the frequency response of the artificial mouth needs
to be equalized. For the equalization of arbitrary signals like the NORMAL speech
signal, R&S UPV-K92 provides an off-line filtering tool that compensates the
frequency response of the artificial mouth used in order to generate an
acoustically correct spectrum of the test signal at the mouth reference point
(MRP).



Acoustic Measurements on Mobile Phones

2 Preparation and Start of the Application Software

Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the
measurements:

e Base Software for Mobile Phone Tests R&S UPV-K9
¢ CDMA2000® Mobile Phone Tests R&S UPV-K92

The CDMA2000® 1xRTT mobile phone under test is connected via the RF
interface using the Universal Digital Radio Communication Tester R&S
CMU200, called herein below CMU200. This tester simulates a base station
for the mobile phone so that a call can be set up. The CMU200 must be
equipped with the options CMU-B83 v22 (CDMA2000 1xRTT Signalling
Unit), CMU-B85 v22 (8k/13k QCELP, 8k EVRC, EVRC-B Speech Codec)
and the appropriate software options CMU-K8x for the band used
(CMU-K83: 450MHz bands, -K84: Cellular bands, -K85: PCS bands, -K86:
IMT-2000 bands). The firmware level in the CMU200 must be 3.50 or
higher.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements. The following equipment
from Briel & Kjeer or G.R.A.S. is normally used:

Device Description Type (examples)

Telephone test head Device for fixing the DUT in the B&K 4602B

prescribed position

Wideband ear simulator IEC 711 type occluded ear simulator
with adapters for connection to the

ear piece of the DUT

B&K 4195 (type 3.2)

B&K 4227 or
G.R.A.S. 44AB or
44AA (with power
amplifier)

B&K 4128 D

Artificial mouth Special loudspeaker for simulation

of the mouth

Head and torso simulator with
artificial ear (type 3.3) and artificial
mouth, may be used alternatively to
the abovementioned devices

Head and torso simulator

Measurement microphone | %" or ¥4” measurement microphone
for measurement of artificial mouth
output during calibration. This
microphone can use the preamplifier

of the artificial ear.

B&K4191 (free field,
may be used for
hands free tests),
B&K 4192 (pressure
field, may be used
with type 1 art. ear)

B&K 4231

Acoustic calibrator Sound level calibrator for calibrating

the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

Microphone power supply Power supply and preamplifier for

the measuring microphone

Note:

With the amplifier set to 0 dB, the microphone power supply B&K

2690A08S2 produces too much noise for measuring idle noise and
distortion. It is therefore advisable to set a gain of 20 dB.

1402.0643.12 6
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A cable with a BNC connector and special small or angled banana plugs is
required for connecting the artificial mouth, as the space between the
mouth connectors and the test rack (B&K 4602B) is too small for common
banana plugs.

The NORMAL speech signal has a high crest factor (approx. 24 dB peak-
to-rms value). Therefore, the R&S UPV generator cannot deliver enough
peak power to drive the artificial mouth even using the impedance
transformer that is supplied along with option R&S UPV-K9. Thus, it is
necessary to connect the artificial mouth via an additional audio power
amplifier. In this case, the impedance transformer is not required. The
generator 1 output of the R&S UPV is connected to the power amplifier
input, and the power amplifier output is connected to the artificial mouth.

Any standard small audio power amplifier can be used for this task. An
output power of only a few watts is sufficient. The most important factor is
the long-term stability of the gain of this amplifier. The gain should be set in
the range of approx. 10 dB (factor 3) und must remain unchanged after
mouth calibration. An amplifier with a means of holding the volume control
steady or at least with a lock knob for the volume control is preferred in
order to avoid any unwanted gain variation.

A cable with male (analyzer) and female (generator) XLR connector is
supplied for connection to the "Speech" connector of the Digital Radio
Communication Tester CMU.

UPV Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU.
Depending on the CMU hardware, link handler #2 in the CMU can also be
used for CDMA2000, in particular if the CMU also supports GSM and/or
WCDMA. In this case, the supplied adapter must be inserted between the
cable and the speech connector on the CMU.
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Caution: Ifthe CODEC calibration fails, the adapter has most likely to be
inserted.

The CMU connects pin 1 of the R&S UPV generator output to
the equipment grounding conductor of the mains. If an external
power amplifier is used, care must be taken that the external
power amplifier does not connect R&S UPV generator output pin
2 to the equipment grounding conductor of the mains. If
available, a balanced connection to the power amplifier should
be preferred.

An external power amplifier should be switched on after the
R&S UPV-K9y program has been started, and switched off
before the program is ended. This prevents the artificial mouth
from undue power loading by setups which are loaded external
to the application.

An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K9y does not support the use of headphones. Do not
connect headphones to the R&S UPV during mobile phone
tests. High level signals may be present at the headphone
connector.

The program required and the associated files are in the folder “UPV-K9y
Software” on the installation CD supplied with the R&S UPV-K92 option.
The audio analyzer must meet the following firmware requirements:

e R&S UPV firmware version 2.1.1.261 or higher
e Option R&S UPV-K9 installed
e Option R&S UPV-K92 installed.

Installing the Software

The application program requires option keys K9 and K92 to be installed.
The keys are installed in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the keys
as well as the installation manual are part of the delivery.

It is recommended to copy the files MCRInstaller.exe, UPV-K9y.msi,
Config.ini, dotnetfx.exe, Setup.exe and Settings.ini from the folder “UPV-
K9y Software” on the installation CD to drive D: on the R&S UPV hard disk
drive, e.g. to a folder named “D:\R&S Software\UPV-K9y\Version x.y". First,
start “MCRInstaller.exe” to install the Matlab runtime for the offline filter tool.
Next, run the file “Setup.exe” to start the installation. Follow the instructions
of the installer on the screen.

1402.0643.12 8 E-1
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Test Setup
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Fig. 2 Test setup and connection of external components

Starting the Application Software

After installation, the program can be started by double-clicking the lcon
“UPV-K9y Mobile Phone Tests” or by clicking “R&S UPV Applications ->
UPV-K9y Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the artificial
ear and artificial mouth used.

Select Sstandard

glulyl=]

TIA-1042

all cdma tests

r Allewy anly skandand
meazurements

[T Do not show this dislog again

Cancel | Ok

v

Fig. 3 Query window for selection of applied standard
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If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu.

“TIA-1042” comprises sending an receiving tests (frequency response and
loudness rating) for CDMA2000 and AMPS, weighted terminal coupling loss
and the maximum acoustic pressure test from annex B. “all cdma tests”
comprises in addition sidetone masking rating, sending and receiving
distortion and idle channel noise tests according to 3GPP standard. These
tests are not specified in TIA-1042 and offered for information only.

Select Ear Simulator

Type 1

Type 3.2 Low Leak

Type 3.2 High Leak

Type 3.3

Type 3.4

Elechic connection

[nduction cail

[T D not show this dislog again

Cancel | ] 3 I

4

Fig. 4 Query window for selection of artificial ear

®5elect mouth type  [H[=]

LRGFITU-T P.51

HATS ITU-T P52

Genenc speaker

Elechic connection

[T D not show this dislog again

Cancel | Ok J//
a

Fig. 5 Query window for selection of artificial mouth
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When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below). After the last of the three selection windows has been closed, the
main window of the R&S UPV-K9 opens.

@UPV—KQH Mobile Phone Tests (D:'Phone'Results.xml) =10 |

File Data Calbration Measurement Sequence Report  Options  Help

Testresults overview

Date and time | Measurament titls | Test object | “erdi | Comment =
|» | D4/23/2007 14:17:35 COMA Receiving Handset, naom. Yl Sample test object FAIL
|| 04/23/2007 14:24.09 COMA Receiving Handset, nom. ol Sample test object FalL
|| 04/23/2007 14:34.04 COMA Receiving Handset, nom. Yol @ DRP Sample test object FalL
|| D4/23/2007 14:37.01 CDMA Receiving Handzet, nom, Yol @ DRP Sample test object FAIL
|| 0442372007 14:44:37 CDMA Receiving Handset, nom, Vol @ DRP Sample test object FAIL
|| 04/23/2007 15:31:48 COMA Receiving Handset, nom, Val. & DRP Sample test object FalL
|| D4/23/2007 15:38:07 COMA Receiving Handset, nom. Val. @ DRP Sample test object FAIL
|| 0442342007 16:37:45 COMA Weighted Terminal Coupling Loss Sample test object FAIL
|| D4/23/2007 17.37.58 COMA ‘weighted Terminal Coupling Loss Sample test object FalL
|| D4/23/2007 17:45:33 COMA weighted Terminal Coupling Loss Sample test object PaSs
|| 04423/2007 15:01:30 COMA Weighted Terminal Coupling Loss Sample test object PASS
|| 04/23/2007 15:04:16 COMA Weighted Terminal Coupling Loss Sample test object PASS
|| 0442372007 15:70:35 COMA Weighted Terminal Coupling Loss Sample test object FAIL
|| D4/25/2007 15:43:41 COMA Receiving Handset, nom. Val. @ DRP Sample test ohject FAIL
|| 0442572007 155213 COMA Receiving Handset, nom. Yol. @ DRP Sample test object FalL
|| 04/25/2007 15:54:15 COMA ‘weighted Terminal Coupling Loss Sample test object PaSs
|| 04/25/2007 16:48:53 COMA Weighted Terminal Coupling Loss Sample test object PASS
|| 04/25/2007 17.04:40 COMA Weighted Terminal Coupling Loss Sample test object PASS
|| 0442542007 170341 COMA Weighted Terminal Coupling Loss Sample test object FAIL
|| 04/26/200717:63:10 CDMA Sending Handset Sample test object FASS -
|| 0442542007 18:01:02 COMA Sending Handset Sample test object PASS
|| 04/25/2007 15:10:23 COMA Sending Handset Sample test object PasSs
|| 04/25/2007 15:13:23 COMA Sending Handset Sample test object Pass
|| 0442642007 12:18:03 COMA Sending Handset Sample test object PASS
|| D4/26/2007 135111 COMA Sending Handset Sample test object PASS
04/26/2007 14:52:19 COMA Sending Handset Sample test object PASS  This was a good test! =
0490 9007 1E.En.0C COUAA St iminlebn A T sl Ll | C ol bk bt can
1 I
| ‘T_l,lpe 3.2 Low Leak Art.Ear ‘EMLI /CATU | Sample test object
| Report last | Heportlast | | Bt |
measUrement SEQUETICE!

Fig. 6 Main window

Initially the data grid in the center of the screen which shows the result
overview is empty. The screenshot in Fig.6 shows an example after a
number of measurements have been made.

1402.0643.12 11 E-1
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3 Operating Concept

1402.0643.12

R&S mobile phone tests consist of at least two components. R&S UPV-K9
provides the main user interface window, general settings, calibration
routines, data handling, automatic sequencing and reporting tools.

Separate options for different standards (R&S UPV-K92 for CDMA2000
tests) provide test macros for basic measurement types defined in the
standards. Each measurement type provides a set of parameters
(R&S UPV setup files, limits etc.) which are defined in separated
measurement definition files, one for each test case.

Options (General settings)

The “Options” menu in the main window allows to change a set of general
settings like ear type and mouth type used which are valid for all or at least
a plurality of the tests.

“Measurement frequency range” allows to enter the frequency range in
which the artificial head is calibrated. In general this will be 100 Hz to
10 kHz which is the default. “Number of points” specifies the number of
(logarithmically spaced) frequencies measured for the mouth equalization.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 “Calibration” below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.

“Artificial mouth” allows to select the type of artificial mouth used. For
details on the handling of calibration data see section 4 “Calibration” below.

If “Select artificial mouth at startup” is checked, the selection window for
the artificial mouth is opened at each start of the program.

“System simulator” allows to select the type of system simulator used.
For details on the handling of calibration data see section 4 “Calibration”
below.

If “Select system simulator at startup” is checked, the selection window
for the system simulator is opened at each start of the program.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a window before the measurement starts. The operator
may be prompted to position the mobile in a defined way or to set the
volume to a certain setting.

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.

If “Generate temporary export files” is checked, each measurement
macro created “result.exp” with result value and verdict, and, if applicable,
“abscurve.exp” and “relcurve.exp” files with curve data in ASCII format.

12 E-1
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Calibration Devices

R&S UPV-K9 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

@UP?—KEH Mobile Phone Tests {D:"Phone'Results.xml)
File Data | Calibration Measurement Sequence Repork Opkions  Help

7S C

Dat  Microphone ¥ brnent title

. iFici 3 .

» 04,2 oieE] 2ci : eceiving Handset, nom. Wal.

2 DRP to ERF correckion g e
044z Ficia H . eceiving Handzet, norm. Yal.
044z 'ﬁ'rt; Tl (el eceiving Handzet, nom. %ol @ DRI
0442 C'jd ec. | eceiving Handzet, nom. Wal. @& DRI
04/ IT uetion eail | [pceiving Handset, nom, Vol @ DF
04,2 Edectr;:lgunnnefctlnnst , ecelving Handzet, nom. Yol (& DRI
0g/z oM ) ety SR eceiving Handzet, nom. %ol & DRI
04,2 Nelw DEW:'_E eighted Terminal Coupling Loz
044z a8 P gighted Teminal Coupling Loss

- Show all values . . .
044z gighted Terminal Coupling Lozs

- Show selected devices . . .
044z . gighted Teminal Coupling Lozs
0442 M gighted Terminal Coupling Lozs
N4232007 181035 CNkA Weinhted Terminal Coonlinn | azs

Fig. 7 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button.

13 E-1
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@Ealihrated Device -0 x|

Ilzage

| =l
Type

b anufacturer

Senal Mumber

Cancel | | Save and cloze ,I*ﬁ

Fig. 8 Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected with
“Calibration > Select device” in the main menu. Clicking on this item opens
a window with a table of all entered devices.

@)Selett Calibrated Devices = [Olx]
L | b anufacturer | Type ‘ Serial No, | Date and Time ‘ Calib. value | File name = |
L 2l Detallt 9/8/2006 312 Pt 3.304471330505 D:83GPPACa
| |Diftuse field microphane Detault 9/8/2006 3.05 PM A7 NEFAN 70257 DNIGPPACa
| |Electic connection replacing decoder Diefault 71342006 5:54 Phd [rull) D:43GPPACa
| |Electic connection replacing decoder Default 7/13/2006 5:07 PM 35 [D:M3GPPACa
| |Electic connection replacing encoder Default 7/13/2006 5:54 PM (rull) D:MN3GPPACa
| |Electic connection replacing mouth Detault 7/13/200E 5:51 PM [rull) D:M3GPPACa
| |Encoder Detault 9/B/2006 312 PM 1073, 78998233746 D:NIGPPACa
| |Free field microphone Diefault E/7./2006 350 Pt [rull) [:43GPPACa
| |Generic speaker Default /1372008 4:33 PM () [D:MN3GPPACa
| |HATSITU-T P.58 Art. Mouth Detault E/7/2006 3:47 PM (rull D:MIGPPACa
| |HATS Type 334t Ear Detalt E/7/2006 3:52 Pt [ruall) D:83GPPACa
| |HATS Type 3.4 Art Ear Detallt B/7/2006 3:54 Pt [rull) D:83GPPACa
| |Induction coil input) Diefault 7342006 E:04 Phd [rull) D:43GPPACa
| |Input digital Detault E/7/2006 3:43 PM [rull D:MIGPPACa
| |LRGFITU-T P.51 Art. Mouth Detault 9/8/2006 306 PM 178.055148772134 D:MIGPPACa
| |Output digital Detault E/7/2006 3:50 PM (rull D:MIGPPACa
| |Twpe 1At Ear Detallt 9/8/2006 3:37 Pt -17.91907615662 D:83GPPACa
| |Twpe 3.2 High Leak Art.Ear Detault E/7/2006 351 PM [rll DNIGPPACa
| |Twpe 3.2 Low Leak ArLEar Bk 4195 1708754 9/8/2006 5:07 PM [rull D:M3GPPACa
| |Twpe 3.2 Low Leak ArEar Detault 9/8/2006 308 PM -16.845427259569 D:MIGPPACa
i Tupe 3.2 Low Leak Ar.Ear G.R.AS. RAD0SE & RA | 26740 & 4636 |9/8/2006 517 P [rull | D:\3GPF’\E1d
|Select Usage Type j Geleeh Cancel | Ok I

Fig. 9 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with a mouse click on its left end. A mouse click on the button “Select”
selects this device for the associated usage.

14 E-1
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@)Selett Calibrated Devices _ (O] %]
Usage L | b anufacturer | Type ‘ Serial No, | Date and Time ‘ Calib. value | File name
Tupe 3.2 Low Leak Ak Ear Bk 4195 1708754 9/8/2006 5:07 Pt [ruall) D:A3GPPACA33:
Type 3.2 Low Leak A.Ear Detault 9/8/2006 3.08 PM -16.84542729569 DNIGPPACaEE
Type 3.2 Low Leak Ar.Ear G.RAS. RA00SE & RA | 26740 & 4636 |9/8/2006 5:17 P (rull] D:NIGPPACalEE

Select | Cancel | Ok I

Fig. 10 Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K9 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

An overview all selected calibration devices together with the calibration
values is given under the menu item “Calibration - Show selected
devices”.

Microphone Calibration
» Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

» Call the test routine with “Calibration = Microphone - Free field” or
“Calibration - Microphone - Diffuse field” from the main menu,
depending on the microphone.

15 E-1
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Microphone calibration

Connect microphone 1o analyzer input 1.
Insert microphone into calibrator using
adapter UC0210 and switch on calibrator.

[T Calibration level increased by 20 dB [not walidated)

y

Fig. 11 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa,
display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about
10 times higher. If the voltage measured is below 3 mV, an error
message is displayed. Possible error sources are, for example, a
switched-off microphone power supply or a disabled calibrator. In this
case, the program requests that the test be repeated. After switching on
the microphone power supply, wait approx. 20 s before restarting the
measurement with RUN.

Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the
artificial ear must be determined using a sound level calibrator such as the
Briel & Kjeer 4231 with a sound pressure level of 94 dBSPL or a sound
pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1

Note: The use of artificial ear type 1 is not foreseen in TIA-1042. However,
R&S UPV-K9 offers the use of this device regardless whether it is
supported by the particular standard applied.

> Switch off the microphone power supply.

Note: The 200 V polarization voltage of the microphone may cause
a slight electric shock. The current is harmless, but the
microphone preamplifier may be damaged.
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Remove the microphone from the artificial ear.

Screw back the microphone capsule and switch on the operating
voltage.

Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

Select “Calibration - Atrtificial ear - Type 1” from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa,
display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about
10 times higher. If the voltage measured is below 3 mV or fluctuating by
more than 0.2 dB, an error message is displayed. Possible error sources
are, for example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the test be repeated.
After switching on the microphone power supply, wait approx. 20 s
before restarting the measurement.

The reference value measured is stored in a file on the hard disk and
used for all subsequent measurements when the same artificial ear type
1 is used as currently selected.

Calibration of Ear Type 3.2 Low Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 Low Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.
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Reading the Calibration Data of the Artificial Ear of Type 3.2L:

The frequency response of the artificial ear of type 3.2L is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_LL.ADA” from the manufacturer’s calibration disk to a

USB stick or a CD-ROM or make this file available on a network drive via
LAN.

Call the routine “Calibration > DRP to ERP Correction - Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “Phone” directory has been renamed or removed.

Calibration of Ear Type 3.2 High Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration - Artificial ear - Type 3.2 High Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2H is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.2H:

The frequency response of the artificial ear of type 3.2H is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_HL.ADA" from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

Call the routine “Calibration > DRP to ERP Correction = Type 3.2 High
leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “Phone” directory has been renamed or removed.
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Calibration of Ear Type 3.3

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter UA-1546 and switch the calibrator on.

Select “Calibration - Atrtificial ear - HATS Type 3.3” from the main
menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.3:
Call the routine “Calibration > DRP to ERP Correction > Type 3.3

->From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “Phone” directory has been renamed or removed.

Calibration of Ear Type 3.4

>

Remove the pinna and the ear canal simulator, connect the sound
level calibrator tightly to the artificial ear using the short steel adapter
and switch the calibrator on.

Select “Calibration > Artificial ear > HATS Type 3.4” from the main
menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.
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Reading the Calibration Data of the Artificial Ear of Type 3.4:

Call the routine “Calibration > DRP to ERP Correction > Type 3.4
- From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “Phone” directory has been renamed or removed.

Calibration of Artificial Mouth

Before a mobile phone can be tested, the absolute sensitivity and frequency
response of the artificial mouth have to be measured and corrected with the
aid of a previously calibrated pressure-field microphone. The measuring
microphone removed from artificial ear type 1 can be used for this purpose
or an additional microphone capsule is screwed to the microphone
preamplifier. The standard microphone is used as a reference for
determining the frequency response of the mouth. The frequency response
of the microphone can be ignored in the test frequency range (100 Hz to
8 kHz) (see also calibration certificate of microphone capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be
calibrated in the sound-proof test chamber.

First of all, the measuring microphone has to be calibrated.

» Select a reference microphone type with “Calibration - Artificial
mouth - Select reference mic”.

For the selected microphone type, a device must be selected and
calibrated (see above). This device must be connected to R&S UPV
analyzer input 1 via power supply/conditioning amplifier.

If the selected reference microphone is a diffuse field or pressure field
type (e.g. B&K 4131 or 4134) or a microphone from a Type1 artificial
ear, fit the microphone at right angles to the mouth at the mouth
reference point (MRP) using the gauge supplied with the mouth
(positioning at right angles is necessary because diffuse field or
pressure-calibrated microphones have a flat frequency response to
sound from random incident direction and therefore exhibit an emphasis
on high frequencies with frontal sound incidence).

If the selected microphone is a free field microphone, it must be
mounted in the axis of the sound outlet of the artificial mouth.

> Call the calibration routine with “Calibration = Artificial mouth >
LRGP ITU-T P.51” or “Calibration = Artificial mouth > HATS ITU-T
P.58” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an
automatic measurement routine at 1 kHz. The generator voltage required is
stored in a file on the hard disk and used as a reference for all subsequent
settings with the same artificial mouth. If the sound pressure cannot be
adjusted to -4.7 dBPa, an error message is displayed with a request to
check the connection of the artificial mouth and to repeat the measurement.
A possible error source would be that the transformer supplied is not
connected between the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured
and displayed. Next, the frequency response is measured with the
inverse frequency response correction automatically selected in the
generator (equalization). Residual errors caused by nonlinearities of the
speaker in the mouth are measured and taken into account in the final
equalization file as fine correction.
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To verify the results, the absolute sound pressure versus frequency is
measured at a sound pressure of 4.7 dBPa (reference value for most of
the measurements). The absolute sound pressure at each frequency
must be within a tolerance band of £0.2 dB. Correct calibration without
interfering sound yields an almost straight line in the middle between the
two limit lines.

Before sending tests can be performed, a reference spectrum
calibration of the sending signal at the Mouth Reference Point is
required which equalizes the speech signal “Normal” according to the
measured frequency response of the artificial mouth and measures the
resulting acoustic spectrum at the MRP.

» Call the reference spectrum calibration routine with “Calibration >
cdma2000 ref. spectrum > Art. Mouth LRGP ITU-T P.51” or
“Calibration > cdma2000 ref. spectrum - Art. Mouth HATS ITU-T
P.58” from the main menu.

Leave the selected measurement microphone at the MRP for this
calibration, as the spectrum at the MRP has to be measured.

The reference spectrum calibration routine calls an external off-line tool
which equalizes the speech signal “Normal” according to the inverse of
the measured frequency response of the artificial mouth and stores it in
a separate file. Upon its first call, this tool is unpacked from a
compressed file which requires some extra processing time.

Calibration of CMU Speech Coder

The calibration of the speech coder and decoder is necessary to be able to
calculate absolute loudness. Calibration has to be performed only once and
must be repeated only if the CMU used is replaced.

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the CMU under
"Service Cfg.”. Call the calibration routines with “Calibration - Codec” from
the main menu.

The following information is displayed:

Establish call and set 'Bit Stream’ to 'Decodercal'l

Fig. 12 Message box during decoder calibration
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Set up a call to the mobile phone. Set bit stream or voice setting on the
CMU to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the CMU is now measured for a
digital full-scale signal and the required correction value is calculated and
saved in the R&S UPV. The following request is then displayed:

Set ‘Bit Stream' ko ‘EncoderCal'l

Fig. 13 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the speech
coder is measured and the input voltage required for digital full scale is
measured at the speech coder and saved in the R&S UPV.

Before receiving tests can be performed, a reference spectrum calibration
has to be performed which measures and stores the spectrum of the
speech signal “Normal” at the generator output.

» Call the reference spectrum calibration routine with “Calibration >
cdma2000 ref. spectrum - Receiving” from the main menu.

Measurements with natural speech require the measurement of a reference
spectrum in order to be able to calculate the receiving sensitivity from the
spectrum at the ERP (or DRP, respectively). The reference spectrum must
be measured and stored once in advance before the first receiving test can
be made.
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5 Data Entry for Reporting

Operator
Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is

activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data > Test object > New” a description of the device under test
can be entered.

I

I ame

Type

bd anufacturer

Sernial Murmber

Cancel | | Save and cloze k

Fig. 14 Window for input of information about a test object

With “Data - Test object > Select” one of the entered test objects can be
selected. The data of this selected test object will be stored in association
with all measurements and appear on the associated reports if “DUT
information” is activated in the report settings.
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6 Measurements

General

Special problems caused by the coding and decoding algorithms of mobile
phones are encountered when measuring acoustic characteristics.
Vocoders are used to attain the lowest possible data rate. Mobile phone
voice codecs are optimized for transmitting human speech with low data
rate. Not the actual voice signals but only the filter and fundamental
parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. In commercially available mobile phones, no
special test interface is accessible which would allow to measure the
acoustic performance of the mobile without codec involved. Measurements
during normal operation can therefore only be performed via the air
interface with the speech coder and decoder included.

The codec types specified for the use in CDMA2000 phones even do not
transmit complex artificial test signals like modulated multisine according to
ITU-T P.501 or artificial speech according to ITU-T P.50 with sufficient fidelity.
Therefore TIA-1042 specifies the use of natural speech.

Functionality and control of the measurement macros

& DMA Sending Handset 1 [=] 3

-20

Sending sensitivity [dB re 1 W/Pa]

=30

A0 I 1
100 1000 10000
Frequency [Hz]

m Measured. SLR = 3.00 dB . M andatary lower limit m Desired lawer limit
. Mandatory upper limit m Desited upper limit

| |Typa 3.2 Low Leak ArtEa |CMU /CRTU |Samnla test object |

Save curve as | Load curve iy

MeasLrement
Fig. 15 Example of a measurement window

Save curve as
lirni: file:

Erter
Comment

Change Scale Create Report Cloze
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When a measurement macro is started, e.g. from the “Measurement”
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

il L

N a )]

Showe Cursor

Change Scale

[Daka Poink Size
Camrnenk

Save acreenshot as ..,

Fig. 16 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale =]

# MirirnLam # M aximLim
| 100. EIIII::I | 1 IIIEIEIIZI.EIEI::I
" MirirnLam "t amirnm

| S000=] | 0.00=]
Caricel ok |
dnce | /

o

Fig. 17 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.
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Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and noise values are
calculated and displayed in the legend. However, limits are not checked,
and the report shows only the original results.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file, and such curves can
be loaded back into the graph. The softkey “Store Curve” opens a window
in which a combo box offers choice between the legends of all curves in the
graph. The curve associated in which the selected entry is stored to the file
at the specified location.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Storing a Hardcopy of the Graph

With the menu item “Save Screenshot as ...” in the graph context menu, a
hardcopy of the current graph window with all numeric displays, legend etc.
can be stored as image. The current view of the graph including additional
curves, current scaling and size is copied. However, colours are inverted to
a printer-friendly colour set.
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Fig. 18 Hardcopy of measurement graph

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated with
the measurement is imported to the results data. A new entry appears for
the measurement as new row on the bottom of the overview data grid in the
main window.

Notes on Individual Measurements

Sending Frequency Response and Loudness Rating

(“CDMA Sending Handset”, “AMPS Sending Handset” )

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB
of the voltage at the decoder output to the input noise pressure at the
artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating
guard-ring position) according to ITU-T P.76, and the receiver is sealed to
the artificial ear.

Natural speech with an active speech sound pressure level of -4.7 dBPa is
created with the artificial mouth at the MRP (mouth reference point), and
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the corresponding output voltage spectrum is measured at the CMU speech
decoder output and compared to the reference spectrum obtained at the
MRP.

The sending frequency response must be within the (floating) mandatory
limit lines specified according to table 2.2-1 of TIA-1042. The absolute
sensitivity is not yet taken into account.

Table 1 Mandatory limit lines according to table 2.2-1 of TIA-1042

Frequency (Hz) Upper limit (dB) Lower limit (dB)
200 +3

300 -12

1000 +3 -3

2000 +10 -3

3000 -1

3400 +10

Table 2.2-1 also specifies “desired” limit lines as a target for the acoustic design,
which, however, are not mandatory to be passed. The sending tests of
R&S UPV-K92 display also the desired limit template which is centred around
the measured frequency response curve independently from the mandatory
template. A verdict for the desired limit is also shown, which, however, does not
influence the total verdict of the test case.

Table 2 Desired limit lines according to table 2.2-1 of TIA-1042

Frequency (Hz) Upper limit (dB) Lower limit (dB)
200 +3

300 -5

1000 +3 -3

2000 +8

3000 -3

3400 +8

For each of the two templates, the offset of the measured frequency response
to the upper or lower limit line is calculated and then the whole limit template is
shifted to be centred with respect to the measured curve. Then another limit
check is performed. If the shifted curve is now within the limit lines, PASS is
output, otherwise FAIL is displayed. The limit check is performed at each
measured frequency. If the measured value and the end point of a limit line are
not at the same frequency, it may happen that the trace slightly crosses a corner
of the limit line although there are no limit violations. The remaining margin is
displayed. A negative margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance with
the normal sensitivity of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.
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Table 3 Frequencies (Hz) of bands 4 to 17 according to table 1 of ITU-T P.79

200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is defined as the ratio dBV/Pa referenced
to the rated internal level in dBmO, and the sending loudness rating is
calculated according to formula 5-1 of ITU-T P.79. Note that loudness rating
values are loss values, i.e. a high loudness rating values indicates a low
gain and a low loudness rating value indicates a high gain.

Due to the input sensitivity tolerance of the CMU speech coder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the sending loudness rating (see calibration routines).
According to TIA-1042, the sending loudness rating should be between
6 dB and 19 dB, with lower dB values corresponding to greater loudness
(6 dB = maximum loudness, 19 dB = minimum loudness). Target SLR
should be 11 dB. The measured SLR is indicated in a window in the
frequency response display and checked for compliance with these limits.
In addition to the numeric value, either PASS or FAIL is displayed.

The general PASS or FAIL information is obtained from the limit check of the
frequency response curve and the loudness rating. PASS is output only if both
the curve and the loudness value are within tolerances.

The AMPS version of this test ("“AMPS Sending Handset”) automatically looks
for existing CDMA2000 results with the same mobile. If a result is found, the
loudness contrast is displayed and checked against the limit of +3 dB.

& DMA Sending Handset 1 [=] 3

-20

Sending sensitivity [dB re 1 W/Pa]

=30

A0 I 1
100 1000 10000
Frequency [Hz]

m Measured. SLR = 3.00 dB . M andatary lower limit m Desired lawer limit
. Mandatory upper limit m Desited upper limit

| |Typa 3.2 Low Leak ArtEa |CMU /CRTU |Samnla test object |
Save cuve as | Load curve Enter

Save curve as
Comment

lirni: file:

| Change Scale Create Report Cloze

measurement

Fig. 19 Sending frequency response with SLR value displayed
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Receiving Frequency Response and Loudness Rating

(“CDMA Receiving Handset, nom. Vol.”, “CDMA Receiving Handset, max.
Vol.”, “AMPS Receiving Handset, nom. Vol.”, “AMPS Receiving Handset,
max. Vol.”)

The following two measurement definitions are available, as the permissible
limit values of the loudness rating depend on the volume set in the mobile
phone under test: “CDMA Receiving Handset, nom. Vol.” checks loudness
rating limits for nominal loudness setting and at the same time compliance
with the frequency response limit template. “CDMA Receiving Handset,
max. Vol.” checks the receiving loudness rating at the highest volume
setting against a minimum. (Note: As the loudness rating is a loss value, a
high RLR is associated with a soft speech signal and a low RLR is
associated with a loud speech signal).

Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in
dB of the sound pressure in the artificial ear to the input voltage at the
speech coder input of the CMU. The measured sound pressure is
referenced to the ear reference point (ERP). For ear types 3.x, the
measuring microphone is applied to the drum reference point (DRP), which
is the reason why any measured value has to be converted to the ERP by
means of calibration factors. According to TIA-1042, the measurement
must be referenced to the ear reference point (ERP). For information only
there are separate measurements supplied with R&S UPV-K92 which
measure referenced to the DRP.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS. In case of ear type 3.2, the receiver is sealed to the rubber gasket of
the artificial ear. If the low leak version of this ear type is used, care must be
taken that the defined leak opening at the circumference of the artificial ear
is not accidentally covered.

The speech coder is driven such that the received speech has an active
level of -19 dBmO on the digital side. The sound pressure in the artificial ear
is measured and evaluated.

Ear type 1 is not specified in TIA-1042 for measurements on CDMA2000
mobile phones.

The receiving frequency response must be within the (floating) mandatory
limit lines specified according to table 2.1-1 of TIA-1042. The absolute
sensitivity is not yet taken into account.

Table 4 Mandatory limit lines according to table 2.1-1 of TIA-1042

Frequency (Hz) Upper limit (dB) Lower limit (dB)
200 0

300 -34

400 0

800 +9 -9

3000 -9

3400 +9
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Table 2.1-1 also specifies “desired” limit lines as a target for the acoustic design,
which, however, are not mandatory to be passed. The receiving tests of
R&S UPV-K92 display also the desired limit template which is centred around
the measured frequency response curve independently from the mandatory
template. A verdict for the desired limit is also shown, which, however, does not
influence the total verdict of the test case.

Table 5  Desired limit lines according to table 2.1-1 of TIA-1042

Frequency (Hz) Upper limit (dB) Lower limit (dB)
200 0

300 -14

800 -8

1000 0

1600 +6

3000 -8

3400 +6

For each template, The margins of the measured frequency response to
the upper and lower limit lines are calculated separately, and then the whole
template is shifted such that the resulting margins to upper and lower limit
are equal. Then another limit check is performed. If the shifted curve is now
within the limit lines, PASS is output, otherwise FAIL is displayed. The limit
check is performed at each measured frequency. If the measured value and the
end point of a limit line are not at the same frequency, it may happen that the
trace slightly crosses a corner of the limit line although there are no limit
violations. The remaining margin is displayed. A negative margin shows the
amount of limit violation.

Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the tones in compliance with
the difference between an average speech spectrum and the normal
threshold of hearing in quiet of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.

Table 6  Frequencies (Hz) of bands 4 to 17 according to table 1 of

ITU-T P.79
200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is specified as the ratio dBPa/V
referenced to the rated internal level, and the receiving loudness rating is
calculated according to formula 5-1 of ITU-T P.79.

Due to the input sensitivity tolerance of the CMU speech decoder, the
individual sensitivity of the CMU used has to be taken into account in order
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to calculate the receiving loudness rating (see section “Calibration” above).

The receiving loudness rating depends on the receiving loudness set on the
mobile phone under test and, according to TIA-1042, should be between
-5dB and +5dB at a rated loudness setting, with lower dB values
corresponding to a higher loudness.

The RLR must not fall below -18 dB when maximum loudness is set on the
mobile phone. To prevent damage to the human ear, the maximum
receiving loudness must not exceed a certain value.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

With “CDMA Receiving Handset, nom. Vol”, the general PASS or FAIL
information is obtained from the limit check of the frequency response
curve and the loudness rating. PASS is output only if both the curve and the
loudness value are within tolerances.

“‘CDMA Receiving Handset, max. Vol” checks only the RLR against a
minimum of -18 dB. The frequency response curve is shown for information
only.

The AMPS version of this test (“AMPS Receiving Handset”) automatically
looks for existing CDMA2000 results with the same mobile and same volume
control setting. If a result is found, the loudness contrast is displayed and
checked against the limit of +3 dB.
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Fig. 20 Receiving frequency response with RLR value displayed
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Weighted Terminal Coupling Loss (TCLw)
(“CDMA Weighted Terminal Coupling Loss”)

The echo loss is the attenuation between the speech coder input and the
speech decoder output (gain of speech coder + decoder = 1). Normally the
echo loss is caused by internal acoustic coupling between the telephone
receiver and the microphone. Since the echo considerably reduces the
sound transmission quality, it must not exceed a certain value.

The mobile phone under test is positioned according to one of the options
listed in IEEE Std 269-2002. These options comprise the handset to be
mounted on the ear simulator used for the receiving measurements,
suspended in free air under anechoic conditions or facing a hard, smooth
surface free of any obstacles for at least 500 mm. The positioning of the
mobile for this test will greatly influence the result. Hence it should be noted,
e.g. as comment in the measurement result.

Artificial speech “Echoloss” is used as test signal and applied to the speech
coder. The spectral energy distribution of the generated signal is measured
in the third-octave bands from 200 Hz to 4 kHz. At the same time, the
spectral distribution in the output signal of the speech decoder is measured.
The echo loss is calculated from the differences of the bands according to
ITU-T G.122.

The actual gain of the speech coder and decoder must also be considered in
the result. This value is available in the CMU after calibration of the coder. In
addition, the attenuation of the echo path is displayed as a curve.

TIA-1042 specifies a TCLw of at least 45 dB; mobile phones with good echo
cancellers can meet this requirement. Since the microphone of the mobile
phone under test also picks up any side noise and treats it like an echo, it is
essential that the test chamber is well shielded against external noise.

& CDMA Weighted Terminal Coupling Loss _[O]=

-30

40

Echa path gain [dB]

<50

B0

-0

B0 I 1
100 1000 10000
Frequency [Hz]

B, Weasured, TCLw = 55 55 0B

| |Typa 3.2 Low Leak ArtEa |CMU /CRTU |Samnla test object |

Save curve as | Load curve iy

measurement
Fig. 21 Typical result of echo loss measurement

Erter
Comment

Save curve as
lirni: file:

Change Scale Create Report Cloze

1402.0643.12 33 E-1




1402.0643.12

Acoustic Measurements on Mobile Phones

Peak Acoustic Pressure Level

(“Peak Acoustic Pressure Level’)

To avoid damage to the ear in use of the mobile phone, the maximum
sound pressure level generated by the earpiece in the ear of the user
should be limited. IEC 60950-1 specifies a respective test using the test
signal “PeakLevel”, a heavily clipped artificial signal which is designed to
produce a high output level at the speech decoder. The maximum sound
pressure level obtained in the measurement is checked against a maximum
of 42 dBPa (136 dB relative to 20 yPa) as specified in IEC 60950-1.

If a receive volume control is provided at the mobile, this test should be
performed with maximum volume setting.

@)EDMJ\ Peak Acoustic Pressure Level =[O x]

Peak acoustic pressure level = 14.42 dBPa

No Standard [Type 3.2 Low Leak ArtEa [CMU / CRTU Sample test obizct 1 [
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Fig. 22 Typical result of peak acoustic measurement

Sidetone Masking Rating (STMR)
(“CDMA Sidetone masking rating”)

This test is provided for reference only. It is not specified in TIA-1042.

The sidetone path is the deliberate output of a part of the signal picked up
by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is encountered
under normal conditions involving an acoustic path between mouth and ear.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The STMR can only be measured according to standard using ear type
3.2 (low leakage). Measurements with other ear types can be
performed for comparison.
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The artificial mouth generates tones with a sound pressure of -4.7 dBPa at
the MRP (mouth reference point), and the sound pressure is measured in
the artificial ear.

The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating (STMR)
is calculated according to formula 5-1 of ITU-T P.79 with the weighting
factors of table 3 of ITU-T P.79 taken into account. In addition, the gain of
the sidetone path is displayed as a curve.

When the phone is set to rated receiving loudness, the STMR should be
within 13 db and 23 dB according to 3GPP TS 26.131.
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Fig. 23 Typical measurement of sidetone masking rating
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Stability Margin
(“CDMA Stability margin”)

This test is provided for reference only. It is not specified in TIA-1042.

The stability margin is measured to test the susceptibility of the phone to
acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).

To activate the loop, a noise signal of -10 dBmO in line with ITU-T 0.131 is
applied for 1 s and then switched off, with the loop remaining closed.
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Fig. 24 Window during stability margin test
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The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6 dB
are met.

Sending Distortion

(“CDMA Distortion sending (V5)”, “CDMA Distortion sending (V6)”)

This test is provided for reference only. It is not specified in TIA-1042.

The SINAD ratio in the transmit path is measured as a function of the sound
level.

A pulsed sinusoidal tone of 1015 Hz with a pulse length of approx. 340 ms
is used for the measurement. At this frequency, coding yields a sufficiently
stable output signal. Voice recognition continues to be active in the mobile
phone under test due to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is measured at
the CMU decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which
creates a signal level of -10 dBmO in the transmit channel. An automatic
routine varies the sound pressure at the artificial mouth until the desired
level is attained. This value is then used as a reference for determining the
SINAD value versus level.

The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with the
limits specified in table 7 of 26.131 of 3GPP.
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Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether the
sending signal just comprises background noise. With such mobile phones
the sending distortion test according to 3GPP TS 26.132 before release
6.0.0 may be failed at low levels because the 1 kHz sinewave test signal is
classified as background noise and suppressed. For this reason the
sending distortion measurement according to release 6.0.0 and onwards
omits levels below -25 dB and starts at high test tone levels gradually
reducing the level. For this release, use “3GPP Distortion sending, Rel. 67,
for earlier releases use “3GPP Distortion sending, Rel. 4/5”.

Table 7 Limit lines specified in table 7 of 3GPP TS 26.131

dB relative to ARL | Level ratio
-25dB 26.6 dB
-20 dB 30.7dB
-10 dB 33.3dB
0dB 33.7dB
7 dB 31.7dB
10 dB 25.5dB

The measurement is performed up to a maximum sound pressure of 10 dBPa
at the artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be
attained. The actual trace may therefore end at a lower pressure. This occurs
for mobile phones under test which have a low sensitivity in the transmit

direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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Receiving Distortion

(“CDMA Distortion receiving”)
This test is provided for reference only. It is not specified in TIA-1042.

The SINAD ratio in the receiving path is measured as a function of the acoustic
signal level.

A pulsed sinusoidal tone of 1015 Hz is used for the measurement. At this
frequency, coding yields a sufficiently stable output signal.

Voice recognition continues to be active in the mobile phone under test due
to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is applied to the input of the CMU speech coder, and the
SINAD value of the sound pressure in the artificial ear is measured with
psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45 dBmO0 and 0 dBmO0 and compared with the limits given in table 8 of
3GPP TS 26.131.

Table 8 Limit lines specified in table 8 of 3GPP TS 26.131

Level Level ratio
-45 dBm0 17.5dB
-40 dBmO 22.5dB
-30 dBm0 30.5dB
-20 dBm0O 33.0dB
-10 dBm0 33.5dB
-3dBm0 31.2dB
0dBmO 25.5dB

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at all
specified levels. The second measurement is not taken into account for
reporting and Pass/Fail decision.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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Fig. 26 Typical result of receiving distortion measurement
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Idle Channel Noise Sending
(“CDMA Idle channel noise sending”)

This test is provided for reference only. It is not specified in TIA-1042.

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (<30 dB(A)).

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The decoder output voltage is measured, weighted psophometrically
according to ITU-T G.223 and recalculated for the internal level in dBmOp.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile phone
remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes if
the limit value is exceeded.
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Fig. 27 Typical result of sending noise measurement
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Idle Channel Noise Receiving

(“CDMA Idle channel noise receiving, nom. Vol”, “CDMA Idle channel noise
receiving, max. Vol”)

The sound pressure in the artificial ear is measured with the phone set up in
a quiet environment.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied to the speech coder input. The noise level is
measured during the signal pauses. The voice activity decoder is activated
and the mobile phone remains in the active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should
not exceed -57 dBPa(A). In this case use test “3GPP Idle channel noise
receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP Idle channel noise receiving, max.
Vol

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.
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Fig. 28 Typical result of receiving noise measurement
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This measurement makes high demands on the sound insulation of the test
chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the test
mobile phone switched off or without a DUT shows the measurement
reserves of the test equipment. Due to the inherent noise of the Audio
Analyzer R&S UPV, measurements can be made to about -80 dBPa(A) at
0 dB microphone gain, and even to lower values when a higher microphone
gain is set.
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Customizing Measurements

The first item in the “Measurement” menu which is called “Settings” opens a
sub-menu with all available measurements in it. Clicking on a measurement
in this sub-menu opens a window which allows to change parameters of the
selected measurement.

Parameters of Sending Handset with Speech "Normal™

Template Files
No| File: Mame | Tupe | Upper margin [dB] Lower margin [dB
1 COMa_Handset_Sending_M  Mandatoy up 1] 1]
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[
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Progiam File
SFR_tA
Mol File name I
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Number 13: Edit | I= [ Lacked L’:EII

Fig. 29 Measurement setup window

The “Title” appears in the measurement menu and forms the heading of the
report.

The “Description” can be chosen to be included into the report.
“Date” shows the date of the last change to this measurement definition.

“Operator instruction” is the text displayed before the start of each
measurement, provided that the item “Show operator instructions” is
activated in the “Options” menu.

The entry in the field “Program File” designates the measurement type and
must not be changed.

The field “Setup Files” specifies the R&S UPV setups used by the
measurement. The specified file can be replaced by a user defined file but
the number of setups is defined by the measurement type. The customized
setup file must be stored in folder D:\Hearing. It is recommended to
generate customized setups by copying existing ones. Note that changes in
the setup like changing the analysis function or generator signal may cause
malfunction of the measurement. Some parameters of the setup might be
overwritten by the macro during the measurement run.

The field “Template files” specifies limit template curves for the response
curve. The buttons “Add” or “Edit” produce the following input window:
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Fig. 30 Input window for limit template curve

The radio buttons allow to determine whether the given curve should be
used as upper limit, lower limit or for information only (no limit check). The
field “File name” must contain the path name of the file. To generate a new
limit curve file, use the softkey “Save as limit curve” of the respective
measurement window or copy and edit an existing limit file using a text
editor.

All other available parameters of a measurement definition are shown in the
“Parameters” data grid. The rightmost column with the headline “Fixed”
displays whether the respective parameter can be changed by the operator
or not. In “generic’ measurements all parameters may be changed. In
measurements which follow standards, only parameters which are not
determined by the standard may be changed by the operator. The “Edit”
button opens an input window for the parameter in the line specified in
“‘Number”:
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Fig. 31 Input window for parameter value

“Name” appears in the report and explains the meaning of the parameter.
“Type” is determined by the measurement routine and cannot be changed.
In the field “Value” a value must be entered which conforms with the syntax
rules of the selected data type. The syntax is checked automatically when
the text box is left. However there is no check for the allowable range of the
value. Entering inadequate values (e.g. too high levels, negative
frequencies) may cause malfunction of the measurement.

Parameters for the different Measurement Types

Sending Response

Table 9 Available parameters for sending response measurements

Name Type Value Explanation

test signal file String Normal The file cannot be changed by
the operator

wideband Boolean false Selects wideband measurement

(100 Hz to 7 kHz). Not available
in the current version

SLR upper limit (dB) Double 19 Upper limit for SLR limit check
check SLR upper limit Boolean true Upper limit is checked if “true”
SLR lower limit (dB) Double 6 Lower limit for SLR limit check
check SLR lower limit Boolean true Lower limit is checked if “true”
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Sending Response AMPS

Table 10 Available parameters for sending response measurements

Name

test signal file

wideband

SLR upper limit (dB)

SLR check upper

SLR lower limit (dB)

SLR check lower

loudness contrast limit (dB)

check loudness contrast

Receiving Response

Type
String

Boolean

Double
Boolean
Double
Boolean
Double

Boolean

Value

Normal

false

19
false
19
false

true

Explanation

The file cannot be changed by
the operator

Selects wideband measurement
(100 Hz to 7 kHz). Not available
in the current version

Upper limit for SLR limit check

Upper limit is checked if “true”
Lower limit for SLR limit check
Lower limit is checked if “true”

Limit for absolute SLR
difference between CDMA2000
and AMPS

Limit is checked if “true”

Table 11 Available parameters for sending response measurements

Name

test signal file
DRP

Wideband

RLR upper limit (dB)
RLR check upper
RLR lower limit (dB)
RLR check lower

Type
String

Boolean

Boolean

Double
Boolean
Double
Boolean

Receiving Response AMPS

Value

Normal
false

false

true

true

Explanation

The file cannot be changed by
the operator

If “false”, the DRP-ERP
correction is taken into account
Selects wideband measurement
(100 Hz to 7 kHz). Not available
in the current version.

Upper limit for RLR limit check

Upper limit is checked if “true”
Lower limit for RLR limit check
Lower limit is checked if “true”

Table 12 Available parameters for sending response measurements

Name

test signal file
DRP

wideband

RLR upper limit (dB)

RLR check upper

RLR lower limit (dB)

RLR check lower

max. loudness contrast (dB)

check loudness contrast

45

Type
String

Boolean

Boolean

Double
Boolean
Double
Boolean
Double

Boolean

Value

Normal
false

false

false

false

true

Explanation

The file cannot be changed by
the operator

If “false”, the DRP-ERP
correction is taken into account
Selects wideband measurement
(100 Hz to 7 kHz). Not available
in the current version.

Upper limit for RLR limit check

Upper limit is checked if “true”
Lower limit for RLR limit check
Lower limit is checked if “true”

Limit for absolute RLR
difference between CDMA2000
and AMPS

Limit is checked if “true”
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Terminal Coupling Loss

Table 13 Available parameters for sending response measurements

Name

signal file name

rms value (dBFS)

wideband

TCL upper limit (dB)
check upper limit
TCL lower limit (dB)
check lower limit

Peak Acoustic Level

Type
String

Double

Boolean

Double
Boolean
Double
Boolean

Value

Explanation

Echoloss The file cannot be changed by

-12.5

false

false
45
true

the operator

Rms value of the signal file,
cannot be changed by the
operator

Selects wideband measurement
(100 Hz to 7 kHz). Not
available in the current version.
Upper limit for TCL limit check

Upper limit is checked if “true”
Lower limit for TCL limit check
Lower limit is checked if “true”

Table 14 Available parameters for sending response measurements

Name

test signal file name

measurement interval (s)
DRP
upper limit (dBPa)

check upper limit

Sending Noise

Type
String

Double
Boolean

String

Boolean

Value

PeakLevel

10
false

42

true

Explanation

File name (without extension)
of the .wav file used for the
test

Length of the measurement

If “false”, the DRP-ERP
correction is taken into account
Upper limit for sound pressure
level in dBPa

Upper limit is checked if “true”

Table 15 Available parameters for sending response measurements

Name

average count
upper limit [dBmO(P)]

check upper limit
lower limit [dBmO(P)]

check lower limit
weighted spectrum

store spectrum
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Type
Byte

Double

Boolean
Double

Boolean
Boolean

Boolean

Value

10
-64

true
-100

false
true

true

Explanation

Number of averaged
measurements

Upper limit noise level limit
check

Upper limit is checked if “true”

Lower limit for noise level limit
check
Lower limit is checked if “true”

If “true”, the displayed
spectrum is weighted, if “false”,
the spectrum is unweighted

If “true”, the spectrum is stored
for reporting
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Receiving Noise

Table 16 Available parameters for sending response measurements

Name

DRP
average count
upper limit [dBPa(A)]

check upper limit
lower limit [dBPa(A)]

check lower limit
A weighted spectrum

store spectrum

CDMA

Sending Distortion

Type

Boolean
Byte
Double

Boolean
Double

Boolean
Boolean

Boolean

Boolean

Value

false

10

-57

true
-100

false
true

true

true

Explanation

If “false”, the DRP-ERP
correction is taken into account
Number of averaged
measurements

Upper limit for noise level limit
check

Upper limit is checked if “true”

Lower limit for noise level limit
check
Lower limit is checked if “true”

If “true”, the displayed
spectrum is weighted, if “false”,
the spectrum is unweighted

If “true”, the spectrum is stored
for reporting

Adapts the timing of the test for
the CDMA2000 codecs

Table 17 Available parameters for sending response measurements

Name

wideband

average count

number of levels

level 1 (dB relative to ARL)
level 2 (dB relative to ARL)
level 3 (dB relative to ARL)
level 4 (dB relative to ARL)
level 5 (dB relative to ARL)
level 6 (dB relative to ARL)
level 7 (dB relative to ARL)
level 8 (dB relative to ARL)
level 9 (dB relative to ARL)
level 10 (dB relative to ARL)
CDMA
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Type

Boolean

Byte

Parameter count

Double
Double
Double
Double
Double
Double
Double
Double
Double
Double
Boolean

Value

false

10

10
true

Explanation

Selects wideband measurement
(100 Hz to 7 kHz). Not available
in the current version.

Number of averaged
measurements

Number of test levels, equals
number of level parameters
given below

Adapts the timing of the test for
the CDMA2000 codecs
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Receiving Distortion

Table 18 Available parameters for sending response measurements

Name

DRP
average count

number of levels

level 1 (dBmO)
level 2 (dBmO)
level 3 (dBmO)
level 4 (dBmO)
level 5 (dBmO)
level 6 (dBmO)
level 7 (dBmO)
level 8 (dBmO)
level 9 (dBmO)
level 10 (dBm0)
upper SPL limit (dBPa)

CDMA

Type
Boolean
Byte

Parameter count

Double
Double
Double
Double
Double
Double
Double
Double
Double
Double
Double

Boolean

Sidetone Masking Rating

Value

false
5

10

true

Explanation

Number of averaged
measurements

Number of test levels, equals
number of level parameters
given below

Highest SPL for which the
distortion is displayed and
checked in the first test run.
Pushing “Add measurement”
causes all levels to be
measured and displayed

Adapts the timing of the test for
the CDMA2000 codecs

Table 19 Available parameters for sending response measurements

Name

DRP

wideband

STMR upper limit (dB)

check STMR upper limit
STMR lower limit (dB)

check STMR lower limit
CDMA

Stability Margin

Type

Boolean

Boolean

Double

Boolean
Double

Boolean
Boolean

Value

false

false

23

true
13

true
true

Explanation

If “false”, the DRP-ERP
correction is taken into account
Selects wideband measurement
(100 Hz to 7 kHz). Not available
in the current version.

Upper limit for STMR limit
check

Upper limit is checked if “true”

Lower limit for STMR limit
check
Lower limit is checked if “true”

Adapts the timing of the test for
the CDMA2000 codecs

Table 20 Available parameters for sending response measurements

Name

loop gain (dB)

48

Type
Double

Value

6

Explanation

Specifies the gain applied
between decoder output and
encoder input for the stability
test
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7 Automatic Test Sequences

@ Telephone Tests

File Data Calibration Measurement | Sequence Report  Options  Help

Test results overnew

| Measureme
Il | — C F20 INNC C-1 7770 Dhd ZOD Cmed

Fig. 32 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

@UPV—KQV cdmaz000{R) Mobile Phone Tests (D:Phone\Results.xml)

File Data Calbration Measurement Sequence Report  Options  Help

=]
AMPS Receiving Handset, max. Val. [l COMA Sending Handset
AMPS Recsiving Hamdsel, max. Vol @ DRP Append - [ CDMa Idle channel naise sending
P _ ! [ COMA Distartion Sending (v5)
A wl [l COM& Receiving Handset, nom. Vol
AMPS Sending Handset % COMA Idlz channel noi eiving, nom. vol
AMPS Sending Handset with speech "Normal” vl COMa Distortion Receiving
CDM& weighted Terminal Coupling Loss Delete ¥ [l COMA Sidetons Masking Rating
COMA, Distortion Receiving
COMA Receiving Handset, max. Yol Move up
COMA Receiving Handset, max. Yol & DRP
COMA Receiving Handset, nam. Yol
COMA Receiving Handset, nom. Yol & DRP Move down
COMA Idle channel noise receiving, max. vol
COMA, Idle channel noise receiving, nom. wal
CDMA Distertion Sending V5] __ EdtPuamsier |
COMA Distortion sending 6]
COM& Sending Handset Rur highlighted
COMA Idle channel noise sending
COMA, Stability margin
COMA, Sidetone M asking Fiating Clear
Echo Loss with Speech "EchoLoss"
COMA Peak Acoustic Pressure Level Check al
Peak Acoustic Pressure Level with Signal "PeakLes
Distortion Aeceiving
Rieceiving Handset with speech "Mamal”* Uncheck al
Idle channel noize receiving
Digtortion Sending (V5]
Sending Handset with Speech "Narmal 3
Idle channel noize sending S SSRMEED &8
Stability margin
Sidetone Masking Rating with Modulated Multizine
Clase
4| | B
|Nn Standard ‘T_l,lpe 3.2 Low Leak Art.Ear ‘EMLI /CATU | Sample test object 1
me;:l‘llf_‘:em Start sequence i:ﬂgﬁi | et Sten | MH;F;E‘?;L‘?::“ c zqalﬁanrzt:e Save sequence Save and close

Fig. 33 Sequence window

Initially the right checked list box is empty. The list box on the left side
displays all available measurement definitions. A measurement is
appended to the sequence by highlighting it in the list box on the left side
and clicking the “Append” button. Subsequently a measurement, which is
highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X” button. For non-standard
measurements which allow to change parameters like limit curves, it is
possible to edit the parameters before appending the measurement to the
sequence. This is done by clicking the button “Edit and append”. It is for
example possible to assemble a test sequence which contains stability
margin tests with different loop gains.
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Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence window opens with the specified
sequence loaded. The sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

Running a single measurement out of a sequence

If a measurement is highlighted in the right checked list box it can be run
like a single measurement using the button “Run highlighted”, irrespective
of whether it is checked or not. The measurement runs as if it would have
been started from the “Measurement” menu in the main window. That is,
the measurement window stays open for further actions like storing and
loading of curves and reporting until it is closed by the user. This
functionality allows to assemble subsets of customized measurements
without overloading the list in the “Measurement” menu.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.

50 E-1



Acoustic Measurements on Mobile Phones

8 Reporting, Storing, Loading and Deleting Results

1402.0643.12

Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

@Telephune Tests

File Data Calbration Measurem

Open resulks File -

Save resulks |

_ b PR
Mew results File =y

Save resulks as

Load setkings e Fhd
Save settings [ Fhd
Save sethings as [ PM

H P4

Exit =

| lasmmnne 22749 P

Fig. 34 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File - Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Store results as” from the main menu.

Report Settings

With “Report > Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.

Subsequently data associated with the selected measurement is
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assembled, a graph for existing curve data is generated, and the preview
window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Preview Window

@)Repnrt !E E
IR | e i [ o
b ain Report I

CDMA Sending Handset &

ROHDE&.SCHWARZ

Tested 06/12{2007 13:55:25 Print Date: 06122007

Cperatar

Device Under Test:

Marne: Sample test object 1

Type: Type 1

Manufacturer Manufacturer 1 B

Seridl Mumber: 111111

Comment:

Verdict: PASS
]

-
4] | >

|Currant Page Mo.: 1 |Tma| Page Mo 1+ ‘Zoom Factor: Page Width

Fig. 35 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

LI

Alternatively, a page number can be directly entered in the page number
field

1 M+
To open the print dialog for installed windows printers click
3
To open a file selector for export of the report to Crystal Reports report

format, PDF, WORD, EXCEL, EXCEL-Data only format, Rich Text or
editable Rich Text format, click
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iy

The scale of the document in the preview can be adjusted with

age 'width P8
JWhale Page
Hanoz
300%
200%
41505 e
100%
5% -

Fig. 36 Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K9/K92 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by 0= db

Cancel | Ok

4

Fig. 37 Input window for defining a shift of a measured curve for storage as
limit curve

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is
checked, the standard tests generate “abscurve.exp”, “relcurve.exp” and
“result.exp” files similar to those generated by UPL-B9. These files are

always deleted and overwritten by subsequent tests.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a missing
call to the mobile, a wrong setting etc. To delete the result of a particular
measurement, mark the row for the selected measurement in the data grid
of the main window by clicking on the row header to the left, right-click into
the data grid and select “Delete result” from the context menu. After
confirmation by the operator, the selected row of the result overview will be
deleted from the result file together with all associated data.
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Automatic Backup and Restoration of the Results File

In order to speed up the execution of sequences, the result file is only
saved when the program is closed. However, backups of the result file
called “*.xml~1" and “*.xml~2" are stored alternately after termination of
each single measurement and after termination of each sequence (“*”
stands for the name of the results file without extension). If the program is
ended without closing it properly, or if the result file is not existing anymore,
the R&S UPV-K7 will by the time of its next start offer to restore the result
file from the latest backup file:

@Hewer Backup File Found M=l

The last session of this program has ended
prematurely. Not all results have been saved.

Last writing fime of results file:
|1H 172007 4:12:11 PM|

Last writing time of backup file:
|1H 22007 9:40:08 AM

Would you like to backup the contents of the
results file and restore the contents of the backup
file 7

No, keep results file | [ Yes, restore backup file |
A

Fig. 38 Restoration of data from backup file

If it is chosen to restore the result file from the backup, the supposedly
damaged result file is copied do “*.xml~3” before the backup file is copied
to the original name of the results file.
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9 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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10 Appendix A Settings on the Radio Communication Tester

CMU200

1402.0643.12

Hardware and firmware requirements:

» The R&S®CMU200 must be equipped with option R&S®CMU-B41,
Audio Generator and Analyzer *.

» Firmware version 3.60 or later must be installed on the R&S®CMU200.

» An XLR-BNC adapter (1 male, 1 female) and two BNC cables for
connecting the R&S®CMU AUX connectors to the R&S UPV are
required. These adapters are part of R&S UPV-K9.

* If option R&S®CMU-B41 was not installed at the factory, internal FM auto-
calibration of the R&S®CMU200 must be run one time after installation.

Set all necessary AMPS settings in the AMPS menu of the R&S®CMU200.
To activate the external speech connection at AUX1 and AUX2, you must
switch AF Gen to ON and select external reference as the modulation
source:

» From the OVERVIEW menu, press AFMod.Gen.

» Press Mod.G.Deviation and set it to ON with the ON/OFF key (the
deviation value has no influence).

AMPS o : 'l. Conmect
verview contrd
LT Modulation Setup
u
. |+ Signaling Info Modulation
—-— Carrier Freq. Error N o
e SN i
—=-— Total Peak Deviation P G . Appli
p—— OT¥ cation
——— SAT Freguency Error Bandwidth N
——— SAT Peak Deviation MPCI N Analyzer
Dialled Murnber | --- Level
=== ST Frequency Error +Meas. Contral
——— 5T Peak Deviation Repetition Continuous
Stop Condition  |MNone MS Signal
——— Audio Peak Deviation » Analyzer Level
——— RMS*SQRT(2) Dev. > gg g_igﬂa:
» BS Signal .
- 48.4 dBm Carrier Pawer ~AFMod Generatar | AF el B$ Signal
Cantral off on —
LeveliDeviation (2000 mY 8000 Hz
[T AF Analyzer Fregquency 1004 Hz 1004 Hz
0.000 v AF Voitmeter b Filter
2]
& Deviation
8000 Hz|

AF Gen. AF Gen. Mod. G. Mod. Gen.
Level| Frequenc Deviation| Frequenc:

Fig. 39 AMPS overview menu of the CMU200

» Go to the Connection menu and press AF/RF.

» Using the Mod.Source key, select Mod.externRef.
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B AMPS Connection Control Jg Signal On
AF Connector Overview RF Connector Setup
Sl B RF30UT  RF2 RF 1 RF
of & ) Demodout Output
AFIN  AFOUT €
Analyzer o o Generator Ext. Att.
& O» +00d +00a8 +0.0 uB Qutput
Mod. - RF 41N RF 2 RF 1 RF
Source Mod. intern| ¢ nput
Mod. intern [ @- —
Ext. Att.
Mod. extern +00ue +00a8 +00 8| |nput
Mod. extern Ref - —_—

;st Signal — Wideband
l Power

t:nnnectinnl Other Call I MS Signal | BS Signal l Network AFIRFG»I Syne. |._'- 2 |

Fig. 40 Selecting the modulation source for AMPS on the CMU200

Important: If the generator cannot be operated after Mod.externRef is
selected, the generator must first be switched on!

The program allows to measure the sending and receiving characteristics in
the AMPS mode. The measured loudness value as well as the frequency
response are displayed as in the digital mode. The contrast is the difference
between the measured loudness rating of the mobile in analog mode and in
digital mode. When an AMPS test is performed, the program automatically
scans the result data base for matching results in cdma mode (same device
under test, same kind of measurement). If such results exists, the latest of
them is retrieved and used for loudness contrast calculation.

The call must be established in the cdma mode. The standard settings are
SO3 8k Enhanced (low) (EVRC) codec. You should first perform both the
sending and receiving measurements in the cdma mode and then the
analog measurements in the AMPS mode, because the call is interrupted
after fallback from AMPS to cdma.
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ch. 1 N.Amer. : RE1I |C t
Ch.2 CDMAzOO PC“SH Overview E_E)F;; L C::::I

B CDMAZ2000NAPCS Connection Control [g Signal On

—Se‘tup IPrimary Service ClassfSpeech Service/. .. l'ﬁ

Default Settings J
Accept MS Criginated Cal Accept All Calls

rimary Service Class

Selected Service Speech Service

¥ Loopback Service
Speech Service

Selected Service Option Service Option 3

» Service Option 1

Service Option 3

» FCH Config
Voice Coder | 8k Enhanced (Low)
Echo Delay 200 s

» Service Option 17
» Service Option 0x8000
* Test Data Service

Connection | .. ServiceCfg.| BSSignal | Network | AFRFGr| Sync. |EEEE 2 |
—

Fig. 41 Voice coder settings for COMA2000 on the CMU200

For the AMPS measurements in the Handoff menu, select the setting
AMPS fallback. After the HANDOFF key has been pressed, the
R&S®CMU200 makes a handoff to AMPS using the previously (in the
AMPS menu) selected AMPS parameters. The AMPS parameters can also
be set with the Destination Parameter key.

g CDMA200 ",',f{;“ Overview ‘g:::;t

& CDMA2000NAPCS Connection Control [E Connected

Press the "Destination Selection” key
1o select a destination. Handoff

Du‘t'nationl
Sele'tTar et! 8 colection
AMPS (Fallback)

AMPS Destination
CDMA2000 Cell. (Fallback) | | LM
COMA2000 Cell b
er
Cancel
Prepar.
Connection  Handoff |Service Cfg.| BSSignal | Network | AFRF(»| Sync. |MEEE 2 |

Fig. 42 Selecting the fallback target on the CMU200
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. RC 171 | &)
S| CDMA2000',cs" overview 55 | T |5y

B AMPS Connection Control gl Handoff Preparation Call Pending

Press the Handoff| key to perform a handoff

from the origin to the destination network. Handoff
Destination
| AMPS (Fallback) [# - EEEEEH
Destination Parameter Destination
~Other Call f Handoff Param. Parameter
Default Settings ¥
~MS Signal
Yoice Channel (Chn/Freq) | 1 cn 37003 mHz
WMAC 2
Origin
Parameter

Co0ccio0 Handoff | MSSignal | BSSignal | Metwork | AFRFGR| Sync. | I 2 |

Fig. 43 Setting the AMPS parameters for fallback on the CMU200

The connection from the R&S UPV to the R&S®CMU200 for the speech
signal must be changed for this measurement. The generator 2 output from
the R&S UPV must be connected with the AUX1 input of the R&S®CMU,
and the analyzer 2 input of the R&S UPV must be connected with the AUX2
output of the R&S CMU. To do this, remove the cable from the R&S UPV to
the R&S CMU speech connector and make the connections to the AUX
BNC connectors.

CDMA2000® is a registered trademark of the Telecommunications Industry
Association (TIA — USA).
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